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Installation Instructions for 
SL-1 Shift Light and Vehicle 
Data Logger 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. NOT LEGAL FOR 
SALE OR USE IN CALIFORNIA OR ON ANY POLLUTION CONTROLLED VEHICLES.     

OVERVIEW 
The SL-1 is a combination shift light and vehicle 

data logger with the following features: 

 Ultra high brightness red/green/blue LED display that 
can be panel mounted or attached to a tach with a 
supplied bracket. The LED display features full 
spectrum color capability including white with user 
selected colors for each function and automatic 
dimming under low light conditions.    

 Launch and multi-stage shift light capability. A launch 
RPM and up to five shift RPM levels can be defined 
to support up to six gear transmissions.  

 Gear detection is based on vehicle speed (if a vehicle 
speed sensor is available) or RPM drop during shift. 
Vehicle speed based gear detection allows use in 
applications other than drag racing as it allows 
correct gear sensing after downshifts. 

 Launch detection is based on vehicle speed (if a 
vehicle speed sensor is available) or a signal from a 
line lock solenoid.  

 Two independent programmable alarm functions for 
analog inputs. Additional programmable alarm and 
general purpose control output functions are 
described in the software section.  

 Flexible RPM input compatible with high voltage coil 
drive (vehicles with coil packs or distributor ignition), 
standard 12 volt tach signal, or low level logic drive 
(newer vehicles with coil-on-plug).  

 Built-in data logging. Ideal as basic vehicle data 
logger during dyno tuning or on the track. Logs data 
whenever system is armed. Stores last 5 minutes of 
data at 10 samples/second.  

 Data logged includes throttle position, RPM, vehicle 
speed, status of all inputs and outputs, and two 0-5 
volt analog inputs.  

 Heavy duty industrial grade clamping terminal blocks 
allow easy and reliable hookup without soldering or 
crimping. 

 Compact size: 3.3”L x 2.4”W x 1.1”H (not including 
mounting feet and terminal block). 

 USB interface to laptop PC. Powerful Windows 
software for programming controller and 
downloading logged data.     

 
Figure 1 – SL-1 Shift Light 

ADDITIONAL REQUIRED PARTS 
The SL-1 comes with a USB cable and software 

on CDROM. To complete the installation, you will 
require: wire, wire labels, and crimp terminals. Some 
applications may also require additional fuses, 
switches, and relays. The Appendix includes a list of 
recommended parts and suppliers. 

Throttle position sensor (TPS), RPM, and 
vehicle speed sensor (VSS) signal connections are 
required to utilize all the capabilities of the SL-1. You 
will require a vehicle wiring diagram to locate these 
signal connections.  

INSTALLATION 
1. Turn off the ignition switch and disconnect the 

battery ground cable before proceeding. 

2. Select a convenient mounting location for the SL-1. 
The unit is not sealed and must be mounted in a 
dry location away from sources of heat. We 
recommend underdash mounting. The unit is not 
intended for underhood mounting. You can secure 
the SL-1 with two sheet metal screws or Velcro 
tape strips. Orient the unit so that you will have 
easy access to the terminal blocks and USB port.   

http://www.daytona-twintec.com/
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Figure 2 – Basic Hookup 

 

 
3. Refer to Figure 2 for basic hookup. All connections  

can be made with 18-20 AWG wire.  

4. Working with clamping terminal blocks. All 
connections to the SL-1 terminal blocks must be 
clearly identified either by means of distinct wire 
colors or the use of wire labels. If you use distinct 
wires colors, mark up Figure 2 for future reference. 
Refer to the Appendix for recommended wire 
labels. Wire should be stripped back 3/16-1/4 inch. 
No bare wire should be visible outside the terminal 
block. Use a miniature Phillips or flat screwdriver to 
tighten the screws.    

5. LED display. The LED display can be panel 
mounted in a ¾” diameter hole using the supplied 
¾-24 panel nut. The LED display can also be 
attached to a tachometer using the supplied 
bracket and decorative back housing.  

6. Arming switch. The use of an arming switch is 
optional and not required for basic shift light 

functions. The unit can be configured so that it only 
logs data when armed. Alarm and general purpose 
output (GPO) functions are only active when the 
unit is armed. 

7. Switched +12V power. Most vehicles will have an 
accessory fuse that can be used as a source for 
the switched and fused +12V power connection. 
Refer to the Appendix for recommended fuse taps. 

8. Throttle position sensor (TPS) signal. The use 
of a TPS signal is optional and not required for 
basic shift light functions. Most vehicles 
manufactured since 1981 will have a TPS with 0-
5V output located on the throttle body or 
carburetor. Refer to the vehicle wiring diagram for 
details. You can check the TPS signal with a DVM. 
Some late model vehicles with drive-by-wire 
electronic throttle bodies will have a dual output 
accelerator pedal sensor. The signal voltage on 
one output will rise with increasing pedal position 
and the other output will drop. Connect the SL-1 

http://www.daytona-twintec.com/
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TPS input to the rising signal. Solder this signal 
connection and wrap with self vulcanizing electrical 
tape (refer to the Appendix).  

9. RPM signal. Depending on your vehicle type and 
engine control, there are three possible sources for 
the RPM signal: 

a. High level signal on the Coil- terminal of 
most inductive discharge type 
ignitions. This includes most original 
equipment (OE) ignitions except coil-on-
plug with integrated drive electronics. For 
distributorless systems with multiple coils 
or coil packs, you can use any one of the 
Coil- signals. Refer to the vehicle wiring 
diagram for details. The Coil- terminal will 
connect to an ignition module or engine 
control module (ECM). The Coil+ terminal 
will connect to switched +12V. 

b. Tach signal (preferred for best noise 
immunity). The SL-1 is compatible with 
industry standard 12V square wave tach 
signals such as what would be used to 
drive an Autometer or similar aftermarket 
tach. Most aftermarket capacitive 
discharge (CD) ignitions including the 
MSD-6 and Crane HI-6 series have a tach 
output that you can use.  

c. Low level logic signal. This type of signal 
is found on late model vehicles, including 
many imports, that use coil-on-plug with 
integrated drive electronics. Refer to the 
vehicle wiring diagram for details. You can 
use the signal that goes from the ECM to 
any one of the coil-on-plug units.  

Unless you are using the tach terminal on an 
aftermarket ignition or a screw terminal on a coil, 
you should solder the RPM signal connection and 
wrap with self vulcanizing electrical tape (refer to 
the Appendix). During initial setup, you must 
configure an RPM signal level jumper inside the 
SL-1. Refer to the Initial Setup section on page 17 
for details.  

10. Vehicle speed sensor (VSS) signal. The use of a 
VSS signal is optional and not required for basic 
shift light functions. However, if you plan to use the 
launch and multi-stage shift light feature, you must 
connect either a VSS signal or a signal from a line 
lock solenoid (refer to step 11). Most vehicles 
manufactured since 1981 will have a VSS. Refer to 
the vehicle wiring diagram for details. Some late 
model vehicles with anti-skid braking (ABS) and 
electronic stability control (ECS) systems utilize 

individual wheel sensors use to calculate an 
average vehicle speed. Accessing a discrete 
vehicle speed signal on these systems may not be 
possible. You may have to install a driveshaft 
sensor (contact tech support for details). For 
Nissan 350Z applications, you can access vehicle 
speed on the 8P/R signal (pin 26 on the unified 
meter and A/C amp module behind the center 
console).       

11. Optional general purpose input/output (GPIO) 
signal. Refer to Figures 3-5 for GPIO hookup 
options. If you plan to use the launch and multi-
stage shift light feature, you must connect either a 
VSS signal (refer to step 10) or a signal from a line 
lock solenoid as shown in Figure 3. If you use the 
GPIO to control a nitrous system or to retard an 
aftermarket ignition that requires a 12V (active 
high) signal, you must use a relay as shown. Refer 
to the Appendix for recommended relays.  

12. Optional analog input signals. The SL-1 will log 
0-5V data on two analog inputs. Uses include 
logging air/fuel ratio from a wide-band sensor 
system such as a Delphi manifold absolute 
pressure (MAP) sensor as shown in Figure 6 or the 
Daytona Sensors WEGO IIID shown in Figure 7. If 
you are adding a MAP sensor to vehicle not 
originally equipped with one, you can use the +5V 
power from the SL-1 to power the sensor. The 
software is used to set the units and scaling for the 
analog inputs and configure optional alarm 
functions. Refer to the software section for details.   

13. Ground connection. Use 18 AWG wire. Keep the 
ground connection as short as possible. The 
ground connection must go to a chassis ground 
stud (you can usually find one under the dash). If 
you are using the analog inputs, use the same 
ground point for any associated devices in order to 
avoid signals errors due to a ground loop.        

14. Reconnect the battery ground cable. 

 

 

 

WARNING: If you connect a signal from 
a line lock solenoid to the GPIO 
terminal as shown in Figure 3, you 
must install the supplied diode. Failure 
to install the diode will damage the SL-1 
and void the warranty. 

http://www.daytona-twintec.com/
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Figure 3 – GPIO Hookup to Line Lock Solenoid 

 

Figure 4 – GPIO Hookup for Nitrous System Control 

 

http://www.daytona-twintec.com/
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Figure 5 – GPIO Hookup for High Gear Retard 

 

Figure 6 – Analog Input Hookup to Delphi MAP Sensor 

 

http://www.daytona-twintec.com/
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Figure 6 – Analog Input Hookup to Daytona Sensors WEGO IIID Wide-Band System 

 
 
OVERVIEW OF INITIAL SETUP 

The SL-1 requires initial setup to establish  
system parameters. PC Link Shift software is used for 
setup. In addition, the Shift Log data logging software 
is used to check for proper scaling of the throttle 
position, RPM, vehicle speed, and analog inputs. 
Complete the software installation and read the 
software sections of this instruction manual, then 
continue the initial setup steps on page 17.  

PC REQUIREMENTS 
The SL-1 connects to your PC by means of a 

USB interface. A USB cable is supplied with the unit. 
The PC must have a free USB port. If you have an 
older PC without USB capability, you cannot use the 
SL-1.  

We recommend a laptop PC with Pentium 
processor and super VGA display (SVGA with 1024 x 
768 pixel resolution) running Windows XP/Vista/7. 
Data chart display is graphics intensive and a high 
speed Pentium processor is recommended. 
Processors slower than 300 MHz will exhibit sluggish 
program loading and response. The PC must have a 
CDROM drive for program loading.  

PC Link Shift and Shift Log software include 
print commands to print downloaded data. The 
programs have been tested with Hewlett-Packard laser 
and inkjet printers and Epson inkjet printers. We 
recommend using a color inkjet printer. 

USB INSTALLATION 
The USB interface for the SL-1 is based on the 

FTDI FT232R chip and drivers that allow the unit to 
emulate a standard Windows RS-232 COM port. 

http://www.daytona-twintec.com/
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Updated Windows drivers, installation instructions and 
troubleshooting tips are available on the FTDI website 
at www.ftdichip.com.  Additional information and 
troubleshooting tips can be found on the PC Link Tech 
FAQ on our website at www.daytona-sensors.com.  

A new USB driver that simplifies the installation 
process is available. This installs as an executable file, 
similar to other Windows programs. The Windows 
Found New Hardware Wizard will then detect the USB 
device when it is first connected and automatically 
install the correct driver without the user having to 
browse out to the CDROM. 

Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's PC Link Tech FAQ for details. 

1. Make sure the unit is not connected to your PC.  

2. Insert the Daytona Sensors CDROM. When the 
Daytona Sensors autorun menu appears, click on 
Software. Scroll down and click on the USB Driver 
link. When the File Download dialog box appears, 
click on "Run this program from its current 
location." Ignore any security warnings and click on 
Yes to continue.   

3. After installation of the driver is complete, connect 
the unit to the PC with the supplied USB cable. 
The Windows Found New Hardware Wizard will 
appear and complete installation of the USB 
interface.   

COM Port Configuration 

After completing the installation steps outlined 
above, you must configure the new COM port using 
Device Manager.  

1. Windows XP: click Start, Settings, Control Panel, 
System, Hardware, and then Device Manager. 
Windows Vista: click Start, Control Panel, System 
and Maintenance, and then Device Manager. 
Windows 7: Click Start, Control Panel, System 
and Security, and then Device Manager. For more 
information, visit www.pcsupport.about.com. 

2. Scroll down to Ports (COM and LPT). The new unit 
will appear as a USB Serial Port. Click on this new 
port. Click on the Port Settings tab. 

3. Click on Advanced. In most cases the wizard will 
have installed your new unit as COM5. Note the 
COM port number assigned for your system. For 
optimum performance, you should also change the 

BM Options Latency Timer to 2 msec as shown in 
the Figure 7.  

4. Once you have configured a COM port number for 
your new unit, make sure that you use this same 
COM port selection in the software by using the 
Port Setup command from the Communications 
menu. 

Figure 7 – COM Port Configuration 

 

SOFTWARE INSTALLATION 
The software is supplied on CDROM media or in 

the form of a compressed file downloaded from our 
website. The installation process uses InstallShield. 
This industry standard installer is based the new 
Microsoft Windows Installer service that greatly 
reduces potential problems such as version conflicts 
and allows for application self-repair.  

There are two programs to install: PC Link Shift 
and Shift Log. Start by installing PC Link Shift. If you are 
downloading software from the web, only download and 
install one program at a time. Before proceeding with 
installation, shutdown any other applications that may be 
running. For Windows Vista, you must disable the User 
Account Control (UAC) during installation. If you are 
not familiar with the UAC, please refer to the Vista 
UAC Tech Note on our website's Tech FAQ for details.  

Use the Windows Explorer or the Run command 
from the Windows Start Menu to launch setup.exe in the 
PC_Link_Shift  folder on the CDROM or the setup.exe 
file downloaded from our website. InstallShield will install 
the software in an appropriate folder under Program 
Files. 

Repeat the installation process for Shift Log. Use 
the Windows Explorer or the Run command from the 
Windows Start Menu to launch setup.exe in the 
Shift_Log  folder on the CDROM or the setup.exe file 

http://www.daytona-twintec.com/
http://www.ftdichip.com/
http://www.daytona-sensors.com/
http://www.pcsupport.about.com/


 

 
Daytona Sensors LLC, 933 Beville Road, Suite 101-I, S. Daytona, FL 32119                                                 SL-1 
(386) 322-7390   www.daytona-sensors.com  6/2020 

 Page 8 

downloaded from our website. InstallShield will install the 
software in an appropriate folder under Program Files. 

Once InstallShield has completed the 
installation, PC Link Shift and Shift Log will appear on 
the Windows Start Menu. You can then launch them 
just as you would any other Windows program.  

The programs require the Monospace 821 BT 
fixed pitch printer font in order to properly align 
columns when printing. The Monospace 821 BT font is 
included in the distribution media and automatically 
copied to your Windows Fonts folder during 
installation. A backup copy is also placed in the 
program folder. If you accidentally delete this font, use 
the Install New Font command from the Fonts folder 
File menu. The filename associated with Monospace 
821 BT is monos.ttf. 

PC LINK SHIFT SOFTWARE 
Before the SL-1 is armed, you can download or 

upload data with PC Link Shift.  

After PC Link Shift is launched, the main screen 
appears blank. When launched for the first time, the 
program uses COM1 as the default port. In most 
cases, you will have configured the SL-1 USB interface 
to use a different COM port, such as COM5. Use the 
Port Setup command on the Communications menu to 
select the correct COM port. The program will 
remember the new port setup.  

You have two options for obtaining data for 
editing. You can open a previously saved setup file by 
using the Open File command on the File menu or you 
can download data from an attached SL-1 unit by using 
the Download Data From EEPROM  command on the 
Communications menu. Note that SL-1 setup files use 
a .dat extension. You should create a separate folder 
to store these files. A sample setup file (Sample.dat) is 
included in the program folder.    

Once you have SL-1 data, you can edit various 
shift light and alarm parameters, general setup options, 
and scale factors. You can print the displayed setup 
data by using the Print Parameters command from the 
File menu. When you open a file or download data 
from a unit, the data is stored in a buffer memory. 
Once you have completed all your edits, you can save 
the data in buffer memory to a file or upload it back to 
the unit by using the appropriate command from the 
File or Communications menu.  

SHIFT LIGHT SETUP  
Controller scale factors shown in Figure 8 are 

generally established during initial setup (see page 17) 
and with the exception of the data logging interval will 
probably remain unchanged for a particular vehicle. 
Scale factors that you can set include: 

RPM Pulses/Rev  – RPM pulses per revolution 
(PPR). Some general guidelines follow, based on the 
type of signal connected to the RPM input: 

Tach signal. This includes aftermarket CD 
type ignitions with a tach output. In most cases 
PPR= N/2 where N is the number of cylinders. 
For example a 4 cylinder engine would require 
PPR=2 and a V8 engine would require PPR=4 

Distributor type ignition with connection to 
Coil- terminal. Same as for a tach signal. Use 
PPR= N/2 where N is the number of cylinders. 

Wasted spark coil pack (distributorless 
system) with connection to Coil- terminal. Use 
PPR=1. 

Coil on plug (no wasted spark) with 
connection to Coil- terminal or logic level drive 
signal from the ECM. Use PPR=0.5 

RPM Debounce  – RPM signal filtering in 
milliseconds (msec). Use the default value of 0.50 
msec for most applications. Ford 4.6L modular V8 
engines will require a value of 3.5 msec.  

VSS Frequency – sets the correct scaling for 
vehicle speed based on the signal frequency at 60 
MPH. Values vary widely between different vehicle 
applications. Unless you have a scopemeter to 
measure the actual signal frequency, some trial and 
error using the Shift Log software to display the vehicle 
speed will be required to establish the correct setting. If 
you are not using the VSS input, you can ignore this 
parameter. 

Zero TPS – throttle position sensor voltage 
corresponding to zero percent (closed) throttle. You 
can use a DVM or the Shift Log software to establish 
the correct setting.  

100% TPS – throttle position sensor voltage 
corresponding to wide open throttle You can use a 
DVM or the Shift Log software to establish the correct 
setting. The unit requires a rising throttle voltage where 
the 100% value is higher than the zero value. 

Data Logging Interval – you can set the 
interval from 0.1 to 1.0 seconds. Data logging capacity 
is 2700 samples. An interval of 0.1 seconds allows the 
unit to store the last 4.5 minutes of operation. An 

NOTE: When editing, you must tab out (move 
the cursor out) of the field you have edited 
before Windows will recognize the new value. 

http://www.daytona-twintec.com/
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interval of 1.0 seconds corresponds to 45 minutes of 
data. Data is only logged when the unit is armed. For 
drag racing or dyno testing, we suggest that you set 
the interval to 0.1 seconds and select the Data Logging 
Only When Armed option. For general vehicle data 
logging, you can set a longer interval based on your 
requirements. If you change the data logging interval, 
you should also run the Shift Log program and clear 
the data buffer.  

Data Logging Only When Armed – Data is 
only logged when +12 volts is applied to the ARM 
input. Please note that irregardless of this option, other 
functions such as the general purpose output (GPO), 
and user defined alarms are only active when the 
system is armed. The shift light function, including 
multi-stage and launch functions, is always active.      

Minimum LED Brightness - This parameter 
sets the minimum LED brightness under low light 
(night) conditions. A value of 5-10% is reasonable for 
most applications. 100% represents maximum 
brightness. 

Maximum LED Brightness - This parameter 
sets the maximum LED brightness under bright 
daylight conditions. 100% represents maximum 
brightness. 

Multi-Stage Shift Light - Enables launch and 
multi-stage shift light feature. 

VSS Based Gear Detection - Enables gear 
detection based on vehicle speed sensor (VSS). If this 
option is not selected, gear detection is based on a 
signal from a line lock solenoid connected to the GPIO 
input and sensing RPM drop between gears. VSS 
based gear detection allows using the multi-stage shift 
light feature for road racing applications where 
downshifts occur.  

User Data – you can enter up to 32 characters 
of user data such as comments that will be saved in 
EEPROM memory. 

  

Figure 8 – Basic Shift Light Setup 

 

http://www.daytona-twintec.com/
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BASIC SHIFT LIGHT SETUP  
If the multi-stage shift light option is not selected, 

basic shift light setup appears as shown in Figure 8. 
You can select the shift light color and RPM. If you 
click on the Pick Color command, a Windows color 
dialog box appears as in Figure 9. You can select the 
desired color and click on OK. We recommend that you 
only select saturated colors and white. Some 
intermediate color mixtures of red, green, and blue 
may not display accurately and gray shades will 
appear as less intense white illumination.   

Figure 9 – Color Dialog Box 

 

MULTI-STAGE SHIFT LIGHT SETUP 
WITH RPM DROP GEAR DETECTION  

If the multi-stage shift light option is selected, the 
setup appears as shown in Figure 10. Gear detection 
is based on a signal from a line lock solenoid 
connected to the GPIO input and sensing RPM drop 
between gears. This mode of operation is only suitable 
for drag racing. Refer to the installation instructions for 
wiring hookup details. You can select the launch and 
shift light colors using the Pick Color commands same 
as explained above. You can set individual RPM 
values for launch and the shift point for up to five 
gears. If your transmission has less than six gears, just 
set the unused shift points to the same value as used 

for your upper gear. The Short Shift Window value 
provides protection in case you shift before the shift 
point is reached. For the sample data shown, the unit 
would correctly sense a short shift from 1st into 2nd 
gear as low as 5,600 RPM. The Minimum Shift Drop 
value is the minimum RPM drop that must occur 
between gears for the unit to sense a shift.  

The launch RPM value and color is active while 
the line lock solenoid is energized and +12 volts is 
applied to the GPIO input. The LED display will 
illuminate at the launch RPM and start rapidly blinking 
100 RPM higher. Energizing the line lock solenoid also 
resets the gear counter. When the line lock solenoid is 
released, the launch function is disabled and the multi-
stage shift light function becomes active. 

MULTI-STAGE SHIFT LIGHT SETUP 
WITH VSS BASED GEAR 
DETECTION 

If the multi-stage shift light and VSS based gear 
detection options are selected, the setup appears as 
shown in Figure 11. Gear detection is based the 
minimum VSS values entered for each gear. Refer to 
the installation instructions for VSS wiring hookup 
details.  This mode of operation is required for road 
racing where downshifts will occur. You can select the 
launch and shift light colors using the Pick Color 
commands same as explained above. You can set 
individual RPM values for launch and the shift point for 
up to five gears. The minimum VSS value for 1st gear 
is generally set to zero. At zero speed, the launch RPM 
value and color is active. The LED display will 
illuminate at the launch RPM and start rapidly blinking 
100 RPM higher. If the launch feature is not desired, 
just set the launch RPM to a value above the engine 
redline. The minimum VSS for each gear should be set 
to a speed just below the shift point. Precise values are 
not required. If your transmission has less than six 
gears, just set the unused shift RPM points to the 
same value as used for your upper gear and set the 
corresponding minimum VSS to values above the 
normal vehicle top speed.  

 

 

http://www.daytona-twintec.com/
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Figure 10 – Multi-Stage Shift Light Setup with RPM Drop Gear Detection 

 

Figure 11 – Multi-Stage Shift Light Setup with VSS Based Gear Detection 

 

http://www.daytona-twintec.com/
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GENERAL PURPOSE OUTPUT 
(GPO) SETUP 

Use the Edit GPO Parameters command from 
the Edit menu to display the GPO parameters dialog 
box as shown in Figure 12. Please note that the GPO 
function on the GPIO terminal is not available if the unit 
is configured as a multi-stage shift light with RPM drop 
based gear detection. In this mode, the GPIO terminal 
is used as an input for the signal from a line lock 
solenoid. Typical applications include using the GPO 
function as a window switch to control a nitrous 
system, high gear retard, or other accessory.   

Please note that the GPO function is only active 
when the system is armed (+12 volts applied to ARM 
input).      

Enable GPO  – select this option to enable the 
GPO function. 

Minimum RPM and Maximum RPM – RPM 
window within which the GPO is on. 

TPS Off – percent value below which the GPO 
will be turned off. We recommend using a value that is  
5-10% less than the TPS On setting for best noise 
immunity.  

TPS On – percent value above which the GPO 
is on.  

Minimum RPM and Maximum VSS – vehicle 
speed window within which the GPO is on. 

Delay  – time delay (in seconds) from the point 
where all the above conditions are meet to the point 
where the GPO is on. 

Figure 12 – GPO Parameters Dialog Box 

 

USER DEFINED ALARMS SETUP 
Use the Edit User Defined Alarms command 

from the Edit menu to display the User Defined Alarms 
dialog box as shown in Figure 13. The user defined 
alarms are based on signal levels at the two analog 
inputs. Each alarm can be independently enabled. You 
can also select the alarm color. If you click on the Pick 
Color command, a Windows color dialog box appears. 
You can select the desired color and click on OK. We 
recommend that you only select saturated colors and 
white. Some intermediate color mixtures of red, green, 
and blue may not display accurately and gray shades 
will appear as less intense white illumination.  

An alarm is triggered when the corresponding 
analog input signal level drops below or rises above 
set voltage levels. Sliders are used to set the voltage 
levels. To disable low signal level alarm, set the Alarm 
Below slider to zero volts. To disable high signal level 
alarm, set the Alarm Above slider to 5.0 volts. You can 
set minimum TPS, RPM, and VSS conditions that must 
be exceeded before the alarm is triggered. You can 
also set a time delay (in seconds) from the point where 
all the alarm trigger conditions are meet to the point 
where the alarm is on. Setting a short delay helps 
avoid spurious alarms for situations such as 
momentary lean air/fuel ratio (AFR) or overboost 
transients on acceleration.  

Analog input 1 can be configured for general 
purpose 0-5 volt signal levels, use with a wide-band 
air/fuel ratio (AFR) system such as the Daytona 
Sensors WEGO series, or common Delphi manifold 
absolute pressure (MAP) sensors. Alarm signal levels 
are displayed in appropriate units corresponding to the 
options you have selected.  Analog input 2 can be 
configured for general purpose 0-5 volt signal levels or 
use with a wide-band AFR system.  

Please note that the user defined alarms are 
only active when the system is armed (+12 volts 
applied to ARM input).  

http://www.daytona-twintec.com/
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Figure 13 – User Defined Alarms Dialog Box 

 

 

VSS (SPEED) ALARM SETUP 
Use the Edit VSS (Speed) Alarm command from 

the Edit menu to display the VSS (Speed) Alarm  
dialog box as shown in Figure 14. You can select the 
VSS alarm color. If you click on the Pick Color 
command, a Windows color dialog box appears. You 
can select the desired color and click on OK. We 
recommend that you only select saturated colors and 
white. Some intermediate color mixtures of red, green, 
and blue may not display accurately and gray shades 
will appear as less intense white illumination. You can 
also set the minimum and maximum VSS values. The 
alarm is active below and above these values. To 
disable minimum VSS alarm, enter a zero value. The 
disable maximum VSS alarm, enter the value 255. A 
typical application is a pit row speed limit alarm. For 
the sample data shown, the LED would illuminate 
below 60 MPH.   

Please note that the VSS alarm is only active 
when the system is armed (+12 volts applied to ARM 
input).      

Figure 14 – VSS (Speed) Alarm Dialog Box 
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SHIFT LOG SOFTWARE 
After Shift Log is launched, the display options 

screen appears as shown in Figure 15. You can select 
display units and limits. The program will remember 
your selections. You can also bring up the screen by 
using the Display Options command from the Edit 
menu. When you save downloaded data to a file, the 
display option settings are saved along with the data. If 
you later open the file, the same display options will 
reappear. 

Analog input 1 can be configured for general 
purpose 0-5 volt signal levels, use with a wide-band 
air/fuel ratio (AFR) system such as the Daytona 
Sensors WEGO series, or common Delphi manifold 

absolute pressure (MAP) sensors. Signal levels are 
displayed in appropriate units corresponding to the 
options you have selected.  Analog input 2 can be 
configured for general purpose 0-5 volt signal levels, 
use with a wide-band AFR system, or as a scaled 
analog input with custom scaling for other types of 
sensors.  

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the SL-1 USB interface to use a 
different COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup.  

Figure 15 – Display Options 

 
 

When the scaled analog option is selected for 
analog input 2, you can setup custom scaling by 
clicking on Set Scale Factors. The analog input 2 
scaling dialog box will appear. In general, you will enter 
the minimum and maximum input voltages and 
corresponding scaled values displayed on the chart 
along with the desired chart legend. The minimum and 
maximum voltages must be in the range of 0.0-5.0 
volts. The scaled values must be in the range of 0-
10,000. Once entered, analog input scaling values are 
saved with the data.   

Figure 16 shows settings for a typical industrial 
pressure sensor with 0.5-4.5 volt output range, such as 
the SSI Technologies P51 series. In this case, 0.5 volts 

corresponds to 0 psi and 4.5 volts corresponds to 1000 
psi. 

Figure 16 – Analog Input 2 Scaling Example 
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REAL TIME ENGINE DATA DISPLAY 
When the engine is running, you can display real 

time engine data on an instrument panel type screen 
by using the View Real Time Data command on the 
View menu. Please note that real time engine data 
cannot be directly saved by means of the Shift Log 
program. However, this data is constantly being logged 
and can be downloaded (for example at the end of 
series of dyno runs).  

Real time engine data is displayed on an 
instrument panel type layout with round tach and 
speedometer gauges and bar graph type gauges for all 
most other parameters. Status messages are 
displayed in a separate window. If the engine is not 
running most values will appear as zero. 

Displayed parameters include (depending on 
display option settings): 

RPM – engine crankshaft RPM (numeric value 
displayed beneath gauge) 

VSS – vehicle speed in MPH or KPH (numeric 
value displayed beneath gauge) 

TPS – throttle position (0 to 100% or 0 to 5V) 

MAP – manifold pressure in In-Hg or psi (29.92 
In-Hg or 14.7 psi corresponds to sea level 
atmospheric pressure) 

AFR 1, AFR 2 – if you have connected a single 
or dual channel wide-band system to the analog 
inputs, the software can display the air/fuel ratio 

INPUT 1, INPUT 2 – analog voltage (0 to 5V) on 
the analog inputs. Input 2 can also display 
custom scaled values (refer to Display Options 
on page 14). 

BAT – battery voltage 

INPUTS – status of the inputs. 

OUTPUTS – status of the outputs. Note that the 
general purpose output (GPO) is active low 
(switched to ground when on)  

STATUS – general SL-1 status messages 

Figure 17 – Shift Log Real Time Display 
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DATA LOGGING CHART DISPLAY 
You can also display data logged by the SL-1 on a 
chart recorder type screen. Data logged by the SL-1 
must be downloaded before it can be displayed, by 
using the Download Data command on the 
Communications menu. Once data has been 
downloaded, it is automatically displayed. The last 
data logged will appear at the right end of the 
chart. You can save the data by using the Save File 
command from the File menu after closing the chart 
display (data is not lost by closing the chart display). 
You can display a previously saved data file by first 
using the Open File command on the File menu and 

then using the View Chart command on the View 
menu.  

Note that SL-1 data files use a .log extension. 
You should create a separate folder to store these 
files. A sample data file (Sample.log) is included in the 
program folder.     

You have a range of capabilities for analyzing 
downloaded data displayed in the chart recorder 
format. You can select two parameters for display. 
Trace 1 is displayed in red with its Y axis legends on 
the left side of the chart. Trace 2 is displayed in green 
with its Y axis legends on the right side of the chart. 

Figure 18 – Data Logging Chart Display 
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The X axis is always elapsed time. You can 
select from one of three time scales. You can use the 
scroll bar to move the chart display window in terms of 
elapsed time. If you hold the left mouse button down 
within the chart area, a cursor line appears. The exact 
values of the parameters displayed on trace 1 and 
trace 2 and the elapsed time appear in windows above 
the chart. If you want to analyze the elapsed time 
between two events (for example the time required to 
accelerate from 0 to 60 MPH), you can move the 
cursor to the first event and then click on the Reset 
Time Display button. You can print the displayed chart 
to any Windows printer by clicking on the Print button 
(a color inkjet printer is recommended for best results).  

Data parameters include: 

RPM – engine crankshaft RPM 

VSS – vehicle speed in MPH or KPH 

TPS – throttle position (0 to 100%) 

BATTERY VOLTS – battery voltage 

INPUT 1 VOLTS, INPUT 2 VOLTS – analog 
input voltage 

INPUT 1 AFR, INPUT 2 AFR – air/fuel ratio 
based on the exhaust gas oxygen sensor 
reading (10:1 to 20:1). Only applicable if a wide-
band system has been connected to the analog 
inputs 

INPUT 1 MAP – manifold pressure in In-Hg or 
psi (29.92 In-Hg or 14.7 psi corresponds to sea 
level atmospheric pressure). Only applicable if a 
MAP sensor has been connected.  

INPUT 2 SCALED ANALOG  – only applicable 
if input 2 has been configured for a custom 
scaled value (refer to Display Options on page 
14) 

ARM – input displayed as a digital (on/off) signal  

SHIFT LIGHT  – status of launch and shift lights 
displayed as a digital (on/off) signal  

ALARM  – status of any alarm displayed as a 
digital (on/off) signal. When an alarm is active, a 
description of the alarm will appear in the 
controller status box    

GPI – input level on the GPIO terminal displayed 
as a digital (on/off) signal. On means that the 
GPIO is terminal is at +12 volts  

GPO – output status on the GPIO terminal 
displayed as a digital (on/off) signal. On means 
that the GPIO terminal is switched to ground  

The maximum RPM and VSS values displayed 
on the chart depend on the display options settings 
(refer to the Display Options topic). Caution: If these 
maximum values are set lower than the actual 
logged data, the chart cursor function will not 
update the display correctly.  

Additional data is displayed at the lower right 
side of the screen. This data includes: 

Controller Status – general SL-1 status  

Log Interval – the actual data logging interval in 
seconds 

The SL-1 data buffer stores the last 2700 data 
points. With a nominal data logging interval of 0.10 
seconds, this corresponds to 4.5 minutes of data. You 
can set the data logging interval by means of the PC 
Link Shift software.  

You can clear the data within the SL-1 by using 
the Clear Data Buffer command from the 
Communications menu. If you change the data logging 
interval, you should also clear the SL-1 data buffer. 

INITIAL SETUP 
1. Connect the USB cable, start PC Link Shift 

software, and open the sample.dat setup file.  

2. Refer to page 8 for RPM Pulses/Rev setting. Enter 
the setting corresponding to your application and 
upload to the SL-1.  

3. Start the engine. Start Shift Log software and use 
the View Real Time Data command from the View 
menu. Verify correct engine RPM display (should 
display idle RPM value same as vehicle 
tachometer).  

4. If the RPM display is incorrect (too high or too low) 
but not zero, you will need to change the RPM 
Pulses/Rev setting. Turn off the ignition switch in 
between tests. If the RPM display is too low, use a 
lower RPM Pulses/Rev setting. If the RPM display 
is too high, use a higher RPM Pulses/Rev Setting. 
Change the setting as required in PC Link Shift 
and upload to the SL-1.  

5. If the RPM display is zero, you may need to 
change the RPM signal level jumper on the SL-1 
printed circuit board (PCB). Turn off the ignition 
switch in between tests. Remove the top cover of 
the SL-1 housing and refer to Figure 19. The 
jumper has three positions labeled 5V, TACH, and 

http://www.daytona-twintec.com/
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COIL. The default factory setting is in the COIL 
position (for a high voltage coil signal). Move the 
jumper to the TACH position (for a 12V  tach 
signal) and repeat the test. If the RPM display is 
still zero and your engine has coil-on-plug ignition, 
move the jumper to the 5V position (for a logic 
level signal). Do not attempt to use the 5V 
position for any other type of ignition system. If 
the RPM display is still zero, call tech support. 
Reinstall the cover. If required, go back to step 4 to 
establish the correct RPM Pulses/Rev setting. 

Figure 19 – RPM Signal Level Jumper 

 

6. Turn on the ignition key, but do not start the 
engine. In the Shift Log software, use the Real 
Time Display Options command from the Edit 
menu and select Analog (0-5V) Throttle Position 
(TPS) display. Then go back to View Real Time 
Data. Write down the voltage levels for zero 
(closed) and 100% (wide open) TPS. If you want 
very accurate values, you can use a DVM to 
measure the voltage by probing between the TPS 
and ground terminals on the SL-1. Enter the zero 
and 100% TPS values in the PC Link Shift 
software and upload to the SL-1.  

7. Cycle the ignition key off/on. In the Shift Log 
software Real Time Display Options, change 
Throttle Position (TPS) to Percent (0-100). Then go 
back to View Real Time Data and verify that the 
TPS gauge goes between zero and 100% as the 
throttle is opened.  

8. Skip this step if you are not using the VSS 
connection. Establishing the correct VSS scale 
factor in PC Link Shift will require some trial and 
error. Start with the default setting. Arm the SL-1 to 
log speed data while operating the vehicle at a 
known speed. Use Shift Log software and  
download data from the SL-1 to read the logged 
speed data. An alternate approach is to have a 
passenger monitor real time data with Shift Log. 
Use the following formula to calculate the correct 
scale factor: 

      New VSS Freq  =  Original VSS Freq x Speed Reading                                 
          Actual Vehicle Speed 

For example, if the original VSS frequency 
parameter was 145 Hz, the speed reading is 40 
MPH and the actual vehicle speed is 50 MPH, then 
the new VSS frequency parameter should be: 

  116 Hz  =  145 Hz x 40 MPH                                 
               50 MPH 

You may have repeat this process several times 
for maximum accuracy.  

9. Enter reasonable values for PC Link Shift controller 
parameters and general setup and upload to the 
SL-1. Additional information including setup tips for 
common applications is provided on our website at 
www.daytona-sensors.com. If you can’t find the 
information you are looking for, please contact our 
tech support.  

http://www.daytona-twintec.com/
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APPENDIX – RECOMMENDED 
PARTS AND SUPPLIERS 

WIRE 

Wire supplied with most automotive accessories 
is usually un-tinned copper with a low number of 
strands. The unprotected copper in this inexpensive 
wire quickly oxidizes, especially when in contact with 
dissimilar metals on terminals. The low number of 
strands limits life in applications where flexing occurs. 
We recommend the use of high quality industrial grade 
wire with tinned copper strands and a high strand 
count.   

18-20 AWG sizes can be used for all signal and 
low current applications. 16-18 AWG is adequate for 
purge solenoid wiring. 14 AWG should be used for high 
current fuel and nitrous solenoid wiring. Carol UL grade 
1007/1015 wire is available from Digi-Key. 

P/N   Description 

C2040X-100  20 AWG wire (100 foot spool) 

C2064X-100  18 AWG wire (100 foot spool) 

C2104X-100  16 AWG wire (100 foot spool) 

C2105X-100  14 AWG wire (100 foot spool) 

 

Note: replace X with color code B=Black, 
W=White, R=Red, G=Green, A=Orange, 
Y=Yellow, L=Blue, N=Brown, S=Gray,  
V=Violet 

WIRE LABELS 

To avoid confusion and possible serious 
problems, all wires going into terminal blocks must be 
uniquely identified, either by wire color or wire labels 
(also called markers). Using a single wire color (white 
is preferred) along with wire labels is the most cost 
effective solution. A Panduit write-on type label 
dispenser is available from Digi-Key. Use a fine point 
permanent marker to write on these labels. 

P/N  Description 

298-1295 Panduit PLDR-1 label dispenser with
  1.00” x 0.38” write-on area 

You can also use Avery P/N 15510 
weatherproof white labels (1” x 2-5/8”) available at 
Office Depot and other office supply stores. Cut these 
in half and fold over the wire to make a flag style label. 

CRIMP TERMINALS 

High quality crimp terminals and a proper 
crimping tool are required to make reliable electrical 

connections. Crimp terminals commonly sold in 
automotive and hardware stores have brittle vinyl 
insulation that easily cracks. We recommend the use of 
high quality industrial grade nylon insulated crimp 
terminals. The following parts are available from Digi-
Key.       

P/N  Description 

A27241  16-20 AWG #10 ring tongue terminal 

A27246  16-20 AWG 1/4” ring tongue terminal 

A27248  16-20 AWG 3/8” ring tongue terminal 

A27262  14-16 AWG 1/4” ring tongue terminal 

A27264  14-16 AWG 3/8” ring tongue terminal 

A0911  18-22 AWG .110” female quick  
  disconnect terminal 

MNU18-187DFIK 18-22 AWG .187” female quick 
   disconnect terminal 

MNU18-250DFIK 18-22 AWG 1/4” female quick 
   disconnect terminal 

MNU14-250DFIK 14-16 AWG 1/4” female quick 
   disconnect terminal 

A1069  16-22 AWG butt splice 

A1080  14-16 AWG butt splice 

A1086  10-12 AWG butt splice 

SWITCHES 

Safety and reliability concerns dictate the use of 
rugged industrial quality switches. Low profile rocker 
switches are preferred for automotive applications. We 
recommend the C&K DM series miniature rocker 
switches available from Mouser Electronics. The DPST 
version is ideal for use as an arming switch.  

 

P/N   Description 

DM62J12S205PQ DPST  

D105J12S205QA SPDT momentary 

Use the A0911 .110” female terminals for the 
DPST switch and the MNU18-187DFIK .187” female 
terminals for the SPDT momentary switch. Mouser 
Electronics sells a wide range of high quality switches. 
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If you require a different style switch, we suggest that 
you order their catalog.  

RELAYS 

The typical import brand 30-40 amp relays leave 
little safety margin. When used to switch heavy 
inductive solenoid loads,  arcing can result in the 
contacts welding together – a potentially catastrophic 
failure mode. We recommend using Tyco/P&B 
automotive OE grade relays available from Newark 
Electronics and Digi-Key. Use the 40 amp version for 
most applications and the 70 amp version for 
fuel/nitrous solenoid activation. We recommend that 
you use the relay sockets and crimp terminals listed 
along with the relays.  

P/N  Description 

1432791-1 40 amp VF4 series relay 

VCF4-1001 Socket for VF4 series relay 

60249-1 12-16 AWG terminal for VF4 

VF7-41F11 70 amp VF7 series relay 

VCF7-1000 Socket for VF7 series relay 

42281-1 14-18 AWG terminal for VF4 coil
  connections (2 required) 

280756-4 10-14 AWG terminal for VF7 
  contact connections (2 required) 

FUSES AND FUSE TAPS 

ATC series fuses and fuse holders commonly 
used for automotive applications are only available in 
40 amp and lower ratings. For high current 
applications, we recommend the heavy duty 50 amp 
Littlefuse Maxi Fuse series available from Digi-Key.     

P/N  Description 

F1085  Maxi fuse block 

F1038  50 amp Maxi fuse 

 

Fuse taps are a convenient means of accessing 
switched +12V power. Solder the tap onto the fuse and 
use a female quick disconnect terminal for the new 
connection. Fuse taps are available from State Wire 
and Terminal. 

P/N  Description 

ATC-TAP Fuse tap for ATC standard size fuses 

ATM-TAP  Fuse tap for ATM mini fuses 

 

 

RELIABLE CONNECTIONS TO EXISTING 
SIGNALS 

To connect the SL-1, you will have to tap into 
some existing signal wires on the vehicle. We caution 
against using any of the so called “vampire clips” that 
make an insulation displacement connection. These 
have proven very unreliable in racing applications. 
They may even cause the original wire to fray and 
break. We suggest a soldering any connections to 
existing signals. Use a stripping tool to cut through and 
push back about 1/4” of insulation at the spot on the 
original wire where you plan to make the connection. 
Wrap several turns of the new wire around, solder, 
insulate with self vulcanizing electrical tape, and use 
two cable ties to secure the splice as shown. Regular 
electrical tape will tend to unravel. Self vulcanizing 
electrical tape is available from Digi-Key as their P/N 
W213.    

 

 

SUPPLIERS 

Suppliers referenced in the Appendix are listed 
in the table below. Additional suppliers for connectors, 
electronic tools, mechanical hardware, and test 
equipment are listed on our website at     
www.daytona-sensors.com/tech_tools.htm. 

 

 

Supplier Phone Website 

Digi-Key 1-800-344-4539 www.digi-key.com 

Mouser 1-800-346-6873 www.mouser.com 

Newark 1-800-463-9275 www.newarkinone.com 

State Wire 
& Terminal 

1-800-922-6527 www.statewire.com 
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